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Procedure for General Use of the MProbe XPS 
Updated 08/2021 

 
Loading a sample into the XPS:  

1) Fill out the XPS logbook on the computer desk.  Make a note of the pressure readings of IG1 
and IG2 on the valve control panel over the XPS, the time you sign in, and your sample 
material.  Unusually high pressures (ca. IG1 > 10-7 or IG2 > 10-8  Torr) could indicate a 
problem with the instrument and should be brought to the attention of a GLA.  

2) Check the control panel to make sure that gates 3 (N2) and 5 (analysis chamber) are closed 
and that gates 2 (load lock/turbo), 6 (XPS/cryo), and 0 (Load/Lock cryo) are open. XPS stage 
(control 7) can be up (light on) or down. The switch for gate 0 is attached to the left side of 
the XPS table, Figure 1.  

3) Read the pressure in the back chamber on the 
control unit sitting on top of the control panel 
for the gates.  The pressure should read ≈ 10-4 or 
0 Torr (the lowest the capacitance gauge can 
read).  The pressure in the load lock is 
observable on the left ion gauge above the 
control panel.   

4) Check that no samples are in the instrument in 
either the analysis chamber or the load lock.  If 
there is a stub already in the instrument, you 
will need to unload it before you can load your 
own stub.  Do so by following the unloading 
procedure, starting on page 7. 

5) Mount your sample on the XPS stub.  
a) Stubs should be handled only while wearing gloves, and should be stored in a clean, 

sealed container.  Please do not remove stubs from the XPS room.   
b) There are two types of public-use stubs in glass jars on the counter. 

For thin samples (0-5mm): use one of the tall stubs from the glass jars marked 
with yellow tape. 
For thick samples (5mm-1cm): use the short stub from the glass jar marked with 
blue tape. 

c) Wipe the stub with a Kimwipe moistened with isopropanol before use.  Only wipe the top 
of the stub. 

d) Use the screws on the stub to mount your sample securely. If you must use carbon tape 
(only UHV carbon tape is allowed), use only a very small amount and do not load more 
than 3 samples with carbon tape at one time. The screws are preferable; so only use 
carbon tape if absolutely necessary. 

e) Samples should not extend past the edges of the stub. 

Do Not Remove 

Figure 1 Drawing of the MProbe layout. 
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6) To bring the load lock up to atmospheric pressure:  
a) If gate 1 is closed, open it now. 
b) Turn off IG1. 
c) Close gate 0 to the load lock cryo pump, (switch left 

side of XPS table). 
d) Turn off the load lock turbo (Pfeiffer) pump by 

pressing the “ON/OFF” button on the Pfeiffer 
controller to the left of the valve control panel.  The 
mechanical vacuum pump on the floor will turn off 
automatically.  

e) Close gate 2 (load lock/turbo) and wait until you hear 
the gate click shut.  

f) Once gate 2 is closed, open gate 3 (load lock N2).  The 
pressure in the load lock will increase as N2 fills the 
chamber.  When the pressure reads approximately 720 
Torr, the door to the load lock should open. To easily 
remember these steps, think “0,off,2,3,”. 

7) Place the stub onto the load lock arm using the bottom 
notch, Figure 2. The stub has a freely rotating spindle 
below a short, cylindrical collar (see image on page).  The 
bottom notch of the spindle should fit snugly into the arm.  
Rotate the magnet on the arm to lock the stub in place.  
Close the load lock door. 

8) Check that the turbo is stopped.  If it is not, wait until it reads 0 Hz.  The speed of the turbo 
is shown on the turbo controller. It takes about 5 minutes for the turbo pump to stop spinning. 

9) Close gate 3 (load lock N2) and open gate 2 (load lock/turbo).  While holding the door 
closed, turn on the turbo pump by pressing the "On/Off" button on the right side of the “Load 
Lock Turbo” control panel (3,2,on). Watch the pressure in the back chamber; it should 
decrease continuously to the low 10-3 Torr range. The turbo pump occasionally will hang at a 
pressure, if this persists for 30 seconds or more, turn off the turbo pump, wait for it to spin 
down, and restart it.  

10) After a few minutes, the turbo pump should reach 
maximum speed (1500 Hz) and stabilize in power (0-
7W). 

11) When the pressure reaches < 1 x 10-4 Torr, turn on 
IG1.  

12) When the pressure is < 7 ´ 10-5 Torr, open the gate 0 
to the load lock cryo and close gate 1.  Wait for about 
30 to 60 minutes for the pressure to reduce. If the 
pressure is decreasing very slowly your sample is 

Loading Samples 
1. Check no stub in XPS. 
2. Check Turbo on & back 

chamber at low pressure. 
3. open gate 1. 
4. turn off IG1. 
5. close gate 0. 
6. Turn Pfeiffer (Turbo) off. 
7. close gate 2. 
8. Wait for gate 2 to close. 
9. open gate 3. 
10. load stub using bottom notch. 
11. wait for Pfieffer to stop. 
12. hold door, close gate 3. 
13. open gate 2. 
14. Pfeiffer on. 
15. wait for back chamber  < 1 x 

10-4 Torr. 
16. turn on IG1. 
17. open gate 0. 
18. close gate 1. 
19. wait >½ hour till IG1 

< 5 x 10-8 Torr. 

Figure 2.  Picture of the stub with indication of 
where the transfer arm holds the stub. 
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outgassing. Open gate 1 for the first 30–60 minutes to 
increase pumping capacity. 

Moving a sample into the XPS analysis 
chamber:  

1. After 30 minutes check the pressure in the load lock.  It 
should read < 5×10-8 Torr.  If not wait longer.  

2. Gate 2 must be open and gate 1 closed and the PG1 must 
read 0. 

3. Raise the stage by moving switch 7 up. 

4. Open the Motion Control Panel (found in the “View” drop 
down menu). Move the stage so that x, y, and z all equal 0. 

5. Lower the stage by moving switch 7 down (light is off).  
Note the raising and lowering mechanism does not always 
fully lower or raise the stage.  You can help it complete the 
move by using your fingers to push the ring that controls the stage motion as shown in the 

Figure 3 below. The stage must be fully down to load samples and fully up to take data. 

6. Center the stage in x and y directions. 

7. Make sure that the transfer arm is fully retracted (otherwise gate 5 will not operate). 

8. Open gate 5 (to XPS chamber).  This gate may take 10 s to fully open. Switch on the light in 
the analysis chamber.  

9. Use the transfer arm to move the stub into the analysis chamber, stopping the magnet of the 
transfer arm at the beginning of the ‘CAUTION” region on the arm (about a foot from the 
end of the table).  

10. Move the transfer arm slowly when placing the stub on the stage.  The stub is fully on the 
stage when the collar above the stub spindle completely overlaps the semicircular wear mark 
on the stage. If you cannot load the sample using minimal pressure, contact a GLA. Do not 
use excessive pressure. Doing so has damaged the stage in the past. 

Moving sample to XPS 
Stage 

1. IG1 < 7´10-8., and 
PG1=0 Torr. 

2. Check gate 1 closed 
and gate 2 open 

3. Raise stage (switch 7). 
4. Move stage to (0,0,0,0) 

to load stub. 
5. Lower stage (switch 7). 
6. Check to see that stage 

is fully down. 
7. Center stage is x and y 
8. Make sure transfer Arm 

is fully retracted. 
9. Open gate 5. 
10. Move sample with  

transfer arm onto Stage. 
11. Unlock sample from 

arm. 
12. Fully retract transfer 

arm to LL. 
13. Close gate 5. 
14. Raise stage (switch 7).  
15. Check that stage is fully 

up. 
16.  

Figure 3. These pictures show the part that moves to raise or lower the stage. The left-hand picture 
shows the part that moves to control the stub is labeled. The right-hand figure shows how to push 
the movable piece, so the stage is fully up. The center picture shows pushing the piece, so the sage 
is fully down. The sage must be fully down to load and fully up to take date. 
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11. Unlock the stub from the transfer arm.   

12. While watching the stub on the sample stage, withdraw the transfer arm.  If the stub starts to 
move push it back onto the stage and try again.  If you cannot get the stub to stay on the stage 
call a GLA. 

13. Fully retract the transfer arm to the load lock chamber, and close gate 5 (to XPS chamber). 

14. Raise switch 7.  This lifts the stage into the appropriate position to collect data.  Make sure 
the stage is fully in the up position.  The If the gears on the stage and the stub do not mesh, 
try rotating the joystick. 
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Collecting XP spectra:  
1) The computer should be on If not, the computer is located at the back right side of the 

instrument, behind the analysis chamber.  

2) Load the sample into the analysis chamber and raise the stage. 

3) Log in using the ID and password posted on the monitor.  If the computer is restarted you 
will need to reengage the joystick controls.   
a) To do this, first click on the snoopy icon in the taskbar.  
b) Then, start the “ESCA Capture” program and go to View=>Motion Control Pnl.  If the 

button labeled “Joystick” is red, click on it and it should turn green.  

4) Turn on the desk lamp for the XPS. 

5) If it is not already open, open MicroViewer 5MP camera software. Note the camera is upside 
down. The window needs to be positioned so that the center of the small crosshair icon at the 
top of the window lines up with the upper black cross on the right monitor.  This ensures that 
the lower cross near the center of the screen reflects where the X-rays will hit the sample. Do 
not right click within the camera window, doing so will move the program’s crosshairs. If 
the program crosshair does not align with the lower black cross in the center of the monitor 
right click on the screen to move the crosshair to that position. 

6) Make sure that the 9600 (on the electronics rack) has the button for computer lit (push the 
“COMPUTER” button if it is not lit). 

7) Open your personal database in ESCA Capture.   

8) Open the ESCA control Panel, Figure 4, by going 
to View=>ESCA Control Pnl. Make sure that the 
“Xray Gun Operate” check box is checked to turn 
on the high voltage to the gun.   

9) To optimized the z position for the sample: 
a) In the ESCA Control Panel set “CBE” to an 

energy for an element in your sample. A CBE 
of 285 for C 1s or 533 for O 1s should be 
suitable for most samples.  

b) Select a spot size of 800, a Res# of 4, and a 
capture time in “Cap T” of 5.0. If the box that 
should say “Cap T” reads “Avg T”, it can be 
switched to “Cap T” by clicking on it.  

c) The “Scans” box should be unchecked. 
d) Verify that the pressure read by IG2 is < 2 x 

10-8 Torr.  
e) Move the sample under the lower black cross 

on the screen.  

Figure 4. Picture of the ESCA control Panel 



 6 

f) Click the Start box and adjust the z position of the sample until the count rate reads >500.  
Flip the Auto Z switch to the right of the joystick from off to on. Watch the count rate 
increase. Wait at least 10 seconds for the count rate to stablize.  

g) Make sure that your sample is still under the lower black cross. If it is not, navigate to the 
desired position on your sample and redo step f.  

h) Once the count rate has stabilized, with the sample under the black cross, switch the Auto 
Z switch to off.   

i) Once the sample is at the correct height, change the spot size in the ESCA Control Panel 
to “Spot Off” and click Start. You can now close the ESCA Control Panel. 

10) To collect a survey scan of the sample:  
a) make sure the “recipes” button is selected in the upper left-hand corner of the screen.   
b) Select the project and recipe file that contains the appropriate scan parameters.  Recipe 

parameters are shown in the right-hand dialog box in a spread sheet format call an MRS 
table.  Along the far right-hand side of the box are buttons that add, delete, and move 
regions within a recipe.  Following are brief descriptions of some common region 
parameters that are used often: 

 
Note: L3 produces a signal with twice the count rate of L2 at the expense of slight peak 
broadening (on the order of ~35 meV difference in FWHM). Using Res 2 will increase the count 
rate by a factor of ~4 relative to Res 1, but using Res 2 comes with substantial linewidth 
broadening (~160 meV FWHM difference). Users are encouraged to determine what settings are 
best for their specific samples. The last line in the MRS table should always turn off the X-Rays 
by having “off” in the Spot Size column. 
 

c) The available spot sizes for the M-Probe are shown in the table 
to the left.  

d) The last region in every scan must have the “spot size” set to 
“Off.”  This is the only way to turn off the X-ray source.   

e) In the lower right-hand region of the screen, name your project 
and experiment.  You should also add a description of your 
experiment.  Avoid using parenthesis, colons, semicolons, 
dashes, or underscores in your file names.  

f) Save your recipe.   

11) You can use the autosampler function to analyze multiple samples without coming back to 
move the stage by hand. Contact a GLA if you have not been trained on its operation. 

Function  LBE/CBE Window 
Width 

Spot Size Scans/Time Res eV/tesp 

Survey 0 1000 800 2 4 1 
ResHi 101.5 8 L2 or L3 20 1 or 2 0.065 
Survey(Shutoff) 0 1 off 1 4 1 

Spot Size (μm) 
800 
500 
300 
100 
L1 (100x400) 
L2 (250x1000) 
L3 (500x1200) 

 

Table 1 Recipe parameters for taking data on the MProbe. 



 7 

12) Make sure that the analysis chamber pressure is <2 x 10-8 and dropping. Do not 
commence your run if it is not. In the main program window choose the button labeled 
“Run” at the top right hand side of the screen.  

13) The data is automatically saved when you collect it and will only be removed if you 
save/collect new data over it; we recommend that you periodically backup your 
database/protocol to a thumb drive.   

14) At the end of the scan, the file may be opened by selecting the “Experiment” button in the 
upper left-hand corner of the screen. Data may be analyzed using a variety of techniques 
given in the data reduction program.  See the blue binder or a GLA for more information.  

15) Export data to an Excel or Vamas (CasaXPS) file.  This can be done either from either the 
ESCA Capture or ESCA Analysis program. Select which experiment to export, and then 
choose Export from the File menu.  Select “EXCEL” or VAMAS in the dialog box. Excel 
files will show every region of your scan in a different sheet of the workbook.  Save this to a 
disk.  You are responsible for exporting and saving your own data; the MMRC and the XPS 
GLA are not responsible for lost data.   

16) At the end of your run open the ESCA control panel and uncheck the X-ray Gun Operate box 
to turn off the high voltage to the X-Ray gun. 
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Procedure for aligning the camera crosshairs with the X-ray spot 
1. Follow this procedure if you or someone accidentally right clicks in the camera software and 

moves the position of the crosshairs from the set location. 

2. Close the MicroViewer 5MP camera software and reopen it from the desktop icon. This 
ensures the software window is sized correctly. Do not maximize the software. 

3. Move the window to the right monitor and line up the crosshair icon in the top toolbar with 
the upper black cross on the monitor. In this position, with the window this size, the lower 
black cross on the screen marks the center of the X-ray spot.  

4. Right click in the camera software where the black cross is to realign the crosshairs with the 
lower black cross to mark the X-ray spot on the sample.  

 

Unloading the sample: 
1. Check that the load lock is at low pressure < 5 x 10-8 

Torr and PG1=0. 
2. Check that gate 1 is closed and gate 2 open. 
3. Move the stage to the (0,0,0,0) position using the 

Motion Control Panel (found in the “View” drop 
down menu). 

4. Lower switch 7 to lower the stage. Make sure the 
stage is fully down, Figure 3. 

5. Check that the transfer arm is fully retracted. 

6. Open gate 5.  

7. Placing the stub on the transfer arm. Make sure the 
transfer arm fork is closed. Push the transfer arm fork 
onto the stub. Turn the magnet 180° to lock the stub 
on the transfer arm. 

8. Fully retract the transfer arm into the load lock  

9. Close gate 5 (to XPS chamber). 

10. Open gate 1 (load lock/back chamber), close gate 0 
(load lock cryo pump), and turn off IG1. 

11. Turn off turbo, close gate 2, and wait till it is closed 

12. Open gate 3 to let N2 into the load lock.  

Unloading Sample 
1. check IG1 < 5 x 10-8 and 

PG1 =0 Torr. 
2. Check gate 1 closed and gate 

2 open 
3. Move stage to (0,0,0,0) to 

unload stub. 
4. Lower stage (switch 7). 
5. Check stage is fully down. 
6. Make sure transfer arm is 

Fully retracted. 
7. open gate 5. 
8. move stub from XPS stage 

to arm. 
9. move stub to load lock. 
10. Fully retract Transfer arm. 
11. close gate 5. 
12. open gate 1. 
13. close gate 0. 
14. turn off IG1. 
15. turn off Pfeiffer. 
16. close gate 2. 
17. Wait for gate 2 to close 
18. open gate 3. 
19. remove sample. 
20. wait for Pfeiffer to stop. 
21. hold door, close gate 3. 
22. open gate 2. 
23. start Pfeiffer. 
24. wait for P < 1x10-4 Torr. 
25. open gate 0. 
26. close gate 1,turn on IG1. 
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13. When the pressure in the back chamber is ~ 760 the load lock door should open.  

14. Remove stub and wait for the turbo to stop spinning. 

15. While holding the door closed, close gate 3, open gate 2, turn turbo on (3, 2, on). 

16. Sign out in the logbook and note any problems or observations while using the instrument. 

17.  When the turbo reaches full speed and the pressure is < 10-4 Torr, open gate 0 and close gate 
1. Turn on IG1. 

18. When you leave, the load lock should be under stable vacuum with the turbo pump at max 
speed,  

a. gates 2, 6 & 0 should be open and  

b. all others (1, 3, 4, 5) should be closed, and IG1 and IG2 should be reading normal 
low pressures  (mid 10-9 Torr or lower). 

Send questions to  
Sean Byrne: sbyrne@caltech.edu; (636) 489-9691 
Maureen Morla: mmorla@caltech.edu; (831) 240-9751   
Bruce Brunschwig: bsb@caltech.edu; 626 200 7013 
 
 


